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Introducing Real-Time
Workshop® Embedded
Coder™ Software

Product Overview (p. 1-2) Provides a high-level overview of the
Real-Time Workshop® Embedded
Coder™ product, describing its
purpose and major features.

What Can You Do with Real-Time
Workshop® Embedded Coder™
Software? (p. 1-3)

Lists features of the Real-Time
Workshop Embedded Coder product.

What You Need to Know to Use This
Product (p. 1-5)

Describes the prerequisite
knowledge and experience assumed
for using the Real-Time Workshop
Embedded Coder software and lists
related documentation.

Installing Real-Time Workshop®

Embedded Coder™ Software (p. 1-8)
Provides installation notes.

Accessing Real-Time Workshop®

Embedded Coder™ Demos (p. 1-9)
Provides information about
interactive demos and example code
provided to help you learn about
the Real-Time Workshop Embedded
Coder product.
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Product Overview
Real-Time Workshop® Embedded Coder™ software is a separate, add-on
product for use with Real-Time Workshop® software. It is intended for use
in embedded systems development. The Real-Time Workshop Embedded
Coder software generates code that is easy to read, trace, and customize for
your production environment.

Real-Time Workshop Embedded Coder software provides a framework for the
development of production code that is optimized for speed, memory usage,
and simplicity. The software generates optimized ANSI-C or ISO-C code for
fixed-point and floating-point microprocessors. It extends the capabilities
provided by Real-Time Workshop software to support specification,
integration, deployment, and testing of production applications on embedded
targets. It also addresses targeting considerations such as RAM, ROM, and
CPU constraints, code configuration, and code verification.

The embedded real-time (ERT) target provided by Real-Time Workshop
Embedded Coder software is designed for customization. Most users want to
generate code for a particular microprocessor or development board, and to
deploy the code on target hardware with a cross-development system. To do
this, some modifications to the ERT target files are required. This document
and its companion, the Developing Embedded Targets document, describe
how to customize the ERT target for your production requirements.

For large-scale, multimodel projects involving teams of engineers, the
Real-Time Workshop Embedded Coder software offers Module Packaging
Features (MPF) you can use to control the number and organization of files
generated, the location of global identifiers, registration of user-defined data
types, customized comments, and the location of target variables.

For a comparison of Real-Time Workshop and Real-Time Workshop
Embedded Coder, see “What You Can Accomplish Using Real-Time Workshop
Technology” in the Real-Time Workshop documentation.
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What Can You Do with Real-Time Workshop® Embedded
Coder™ Software?

In addition to supporting the features of the Real-Time Workshop® software,
Real-Time Workshop® Embedded Coder™ software:

• Generates ANSI/ISO C or C++ code and executables from Simulink®

models and Stateflow® charts with memory usage, execution speed, and
readability comparable to handwritten code.

• Extends Real-Time Workshop software and Stateflow® Coder™ software
with the optimizations and code configuration features essential for
production deployment.

• Supports all Simulink data objects and data dictionary capabilities,
including user-defined storage classes, types, and aliases.

• Provides an intuitive graphical user interface for creating custom data.

• Concisely partitions multirate code for efficient scheduling with or without
a real-time operating system (RTOS).

• Provides a rich set of commenting capabilities to trace code to models and
requirements.

• Verifies code by automatically importing it into Simulink models for
software-in-the-loop testing.

• Generates code documentation that is integrated with the Simulink Model
Explorer and hyperlinked to the model.

• Provides a Model Advisor that checks your model configuration and offers
advice on how to optimize or tune a configuration set based on your stated
goals or style.

• Generates an extensible main program based on information you provide
for deploying the code in your real-time environment.

• Generates single-rate or multirate code using periodic sample times
specified in a model.

• Applies a strategy called rate grouping for multirate, multitasking models,
which generates separate functions for the base rate task and for each
subrate task in the model.
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• Provides an option to easily transition between the Real-Time Workshop
generic real-time (GRT) target and the Real-Time Workshop Embedded
Coder embedded real-time (ERT) target.

• Provides extensible module packaging features that let you package
generated code to comply with specific software styles and standards.

• Provides capabilities for verifying generated code, including the ability
to import generated code back into Simulink models as an S-function
for software-in-the-loop testing with a plant model, generation of
user-controlled comments and descriptions to improve code readability and
traceability, inclusion of requirements in generated code, and persistent
identifier names for minimizing code differences between model revisions.

• Documents generated code in an HTML report that comprehensively
describes code modules and model configuration settings applied during
code generation.

• Supports international (non-US-ASCII) characters encountered during code
generation when found in Simulink block names and block descriptions,
user comments on Stateflow diagrams, Stateflow object descriptions,
custom TLC files, and code generation template files. For details
about international character support, see “Support for International
(Non-US-ASCII) Characters” in the Real-Time Workshop documentation.

For information on applications of the Real-Time Workshop Embedded Coder
product and how and when you might use it during system development, see
“Introduction to Real-Time Workshop Technology” in the Real-Time Workshop
documentation.
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What You Need to Know to Use This Product

In this section...

“Prerequisites” on page 1-5

“Real-Time Workshop® Embedded Coder™ Documentation Collection” on
page 1-5

“Related Documentation” on page 1-7

Prerequisites
To use the Real-Time Workshop® Embedded Coder™ software, you should
have basic familiarity with MATLAB®, Simulink®, and Real-Time Workshop®

software. If you have not done so, you should read:

• The tutorials in the Real-Time Workshop Getting Started Guide. The
tutorials provide hands-on experience in configuring models for code
generation and generating code.

• “Program Architecture” and “Models with Multiple Sample Rates” in
the Real-Time Workshop documentation. These sections give a general
overview of the architecture and execution of programs generated by
Real-Time Workshop software.

Real-Time Workshop® Embedded Coder™
Documentation Collection
The Real-Time Workshop Embedded Coder documentation collection consists
of the following:

Document Description

(this document) Provides an overview of the Real-Time
Workshop Embedded Coder product and a
collection of tutorials to help you get started
with using the product.
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Document Description

User’s Guide Describes ERT model execution, timing, and
task management; explains how to interface
to and call model code; describes default
ERT code generation options; and discusses
advanced configuration options.

Module Packaging Features Explains how to use the Module Packaging
Features.

Reference Provides reference descriptions of Real-Time
Workshop Embedded Coder functions and
blocks.

Developing Embedded
Targets

Describes requirements and implementation
details for creating custom embedded targets
based on the supplied ERT.
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Related Documentation
If you are planning to implement custom embedded targets, the following
documentation might interest you:

Document Description

Real-Time Workshop User’s Guide:
Writing S-Functions for Real-Time
Workshop

Discusses inlining and code
generation issues relevant to device
drivers and other S-functions

Real-Time Workshop User’s Guide:
Data Exchange APIs

Explains how to interface signals
and parameters within generated
code to your own code; combine code
generated from multiple models into
a single system; and implement
external mode communication with
your own low-level protocol layer.

Target Language Compiler Provides details about the Target
Language Compiler (TLC) needed
to make nontrivial modifications to
the ERT system target file, use TLC
hooks into the build process, use
information from the model.rtw file,
implement inlined device drivers, or
pass information into or out of the
TLC phase of the build process.

Writing S-Functions Explains how to write fully inlined
S-functions. This information is
necessary for developing device
driver blocks for a target.
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Installing Real-Time Workshop® Embedded Coder™
Software

Your platform-specific MATLAB® installation documentation provides all of
the information you need to install Real-Time Workshop® Embedded Coder™
software.

Prior to installing the software, you must obtain a License File or Personal
License Password (PLP) from The MathWorks. The License File or PLP
identifies the products you are permitted to install and use.

If you customize your installation, the installer displays a dialog box that lets
you select the MATLAB products to install. You can select and install only
products for which you are licensed.

Real-Time Workshop Embedded Coder software requires certain other
products, described in the following table, that must be installed for proper
installation and execution.

Licensed Product
Required
Products Additional Information

Simulink® MATLAB —

Real-Time Workshop® Simulink Requires host platform C
compiler (Microsoft Visual
C/C++ or Watcom C/C++).
Stateflow® Coder™ software is
also required when generating
code for Simulink models
containing Stateflow® charts.

Real-Time Workshop
Embedded Coder

Real-Time
Workshop

Requires a cross-compiler for
the target processor.

If you experience installation difficulties and have Web access, use the
resources available on the MathWorks Web site Installation and Licensing
page at http://www.mathworks.com/support/install.html.
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Accessing Real-Time Workshop® Embedded Coder™
Demos

The Real-Time Workshop® demo suite contains many demos to familiarize you
with features of Real-Time Workshop® Embedded Coder™ software and to
inspect generated code. These demos illustrate features specific to Real-Time
Workshop Embedded Coder software and also general Real-Time Workshop
features as used with Real-Time Workshop Embedded Coder software.

To open the demo suite by entering the following demo library name at the
MATLAB® command prompt:

rtwdemos

Most of the demos provide a button titled Generate Code Using Real-Time
Workshop Embedded Coder. When you click this button, the demo
auto-configures itself for code generation using the ERT target, and then
initiates the code generation process. If your installation is licensed for
Real-Time Workshop Embedded Coder software, use this button.

If your installation is not licensed for Real-Time Workshop Embedded Coder
software, you can run most of the demos by clicking on the Generate Code
Using Real-Time Workshop button. When you click this button, the demo
auto-configures itself for code generation using the GRT target, and then
initiates the code generation process. Note that the GRT target provides a
subset of the capabilities of the ERT target.
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Learning and Using
Real-Time Workshop®

Embedded Coder™
Software

Using the Tutorials (p. 2-2) Describes the tutorials.

Understanding the Demo Model
(p. 2-5)

Acquaints you with the model used
in the tutorials.

Configuring the Data Interface
(p. 2-23)

Guides you through the steps for
configuring a data interface.

Partitioning Functions in the Code
(p. 2-38)

Guides you through the steps for
partitioning functions in generated
code.

Calling External C Functions from
the Model and Generated Code
(p. 2-51)

Guides you through the steps for
calling external C functions.

Integrating the Generated Code into
the External Environment (p. 2-58)

Guides you through steps for
integrating generated code.

Testing the Generated Code (p. 2-66) Guides you through steps for testing
generated code.

Evaluating the Generated Code
(p. 2-75)

Guides you through the evaluation
of generated code.
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Using the Tutorials

In this section...

“Introduction” on page 2-2

“Prerequisites” on page 2-3

“Third-Party Software” on page 2-3

“Setting Up the Tutorial Files” on page 2-4

Introduction
The process for designing and implementing a control algorithm for an
embedded real-time application varies among different organizations.
However, some basic steps in the process are common. This getting started
documentation contains seven tutorials that apply MathWorks products
to those common steps. Each tutorial focuses on a specific aspect of code
generation or integration and is self-contained. You can step through them in
any order, and skim or skip any that do not apply to your needs. The seven
tutorials are:

• “Understanding the Demo Model” on page 2-5

• “Configuring the Data Interface” on page 2-23

• “Partitioning Functions in the Code” on page 2-38

• “Calling External C Functions from the Model and Generated Code” on
page 2-51

• “Integrating the Generated Code into the External Environment” on page
2-58

• “Testing the Generated Code” on page 2-66

• “Evaluating the Generated Code” on page 2-75

In these tutorials, you work with a Simulink® model, read data into it, and
use Real-Time Workshop® Embedded Coder™ software to generate code for
the model, integrate the generated code with an existing system, and validate
simulation and executable results. Each tutorial uses a unique version of the
model and its associated data, which you load as instructed.

2-2



Using the Tutorials

As you proceed through the tutorials, you save each model after you have
worked on it, capturing your modifications to the model and model data.
Saving the model and data preserves them for future examination. To prevent
any errors from carrying over, you begin the next tutorial by opening a
preexisting model and loading preexisting data.

These tutorials are intended for online use. Each contains cross-references
to related documentation and provides instructions for performing specific
tasks. If a task fails for any reason, error messages appear in the MATLAB®

Command Window.

Prerequisites
The tutorials in this book assume the following prerequisite knowledge:

MathWorks products

• How to read, write, and apply M-file scripts

• How to create a basic Simulink model with Stateflow® charts

• How to run Simulink simulations and evaluate the results

C programming

• How to use C data types and storage classes

• How to use function prototypes and methods of calling functions

• How to compile a C function

Metrics for evaluating embedded software

• How to evaluate basic code readability

• How to evaluate RAM/ROM usage

Third-Party Software
Installing and Using an IDE for Integration and Testing explains how to
install third-party software, the Eclipse IDE and the Cygwin/gcc compiler,
which you can use to integrate code that you generate into an external
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development environment for testing. That section also explains how to
integrate the generated code into the external environment.

Setting Up the Tutorial Files
Set up a directory for your tutorial work:

1 Create a writable working directory outside the scope of your MATLAB
installation directory. This tutorial refers to the created working directory
as MyPlayArea.

2 Copy the following files from matlabroot/toolbox/rtw/rtwdemos to the
directory you just created:

• rtwdemo_PCG_Eval_P1.mdl

• rtwdemo_PCG_Eval_P2.mdl

• rtwdemo_PCG_Eval_P3.mdl

• rtwdemo_PCG_Eval_P4.mdl

• rtwdemo_PCG_Eval_P5.mdl

• rtwdemo_PCG_Eval_P6.mdl

• rtwdemo_PCGEvalHarness.mdl

• rtwdemo_PCGEvalHarnessSFun.mdl
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Understanding the Demo Model

In this section...

“Introduction” on page 2-5

“Understanding the Model’s Functional Design” on page 2-5

“Viewing the Top-Level Model” on page 2-6

“Viewing Subsystems” on page 2-7

“Understanding the Simulation Testing Environment” on page 2-8

“Running the Simulation Tests” on page 2-12

“Viewing the Configuration Options for Code Generation” on page 2-13

“Generating Code for the Model” on page 2-19

“Examining the Generated Code” on page 2-20

“See Also” on page 2-22

Introduction
This tutorial introduces the model from a behavioral and structural
perspective, and explains how code is generated and shows the basics of
configuring the model.

In this tutorial you:

• Understand the functional behavior of the model

• Understand how the model is validated

• Get familiar with model checking tools

• Get familiar with configuration options that affect code generation

• Learn how to generate code from a model

Understanding the Model’s Functional Design
This demo uses a simple but functionally complete model of a throttle
controller. The model features redundancy, which is common for safety-critical
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drive-by-wire applications. The model highlights a standard model structure
and a set of basic blocks used in algorithm design.

In the current configuration, the model generates code. However, the code is
not configured for a production target system. This demo guides you through
the steps necessary to change the target configuration and shows how the
format of the generated code changes with the completion of each task.

Viewing the Top-Level Model

1 Open the top-level model by entering rtwdemo_PCG_Eval_P1 at the
MATLAB® command line.

The top-level model consists of:

• Four subsystems: PI_ctrl_1, PI_ctrl_2, Define_Throt_Param, and
Pos_Command_Arbitration

• Top-level inputs: pos_rqst, fbk_1, and fbk_2

• Top-level outputs: pos_cmd_one, pos_cmd_two, and ThrotComm

• Signal routing
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• No transformative blocks (blocks that change the value of a signal, such as
Sum and Integrator blocks)

The layout shows a basic model architectural style.

• Separation of calculations from signal routing (lines and buses)

• Partitioning into subsystems

You can apply this style to all types of models.

Viewing Subsystems
Two subsystems represent PI controllers, PI_cntrl_1 and PI_cntrl_2. These
identical subsystems, at this stage, use identical data. Later, you use the
subsystems to learn how Real-Time Workshop® software can create reusable
functions.

PI Controller Subsystems
Open the PI_cntrl_1 subsystem by double clicking the subsystem block.

The PI controllers are included in the model from a library, a group of related
blocks or models intended for reuse. Libraries provide one of two methods
for including and reusing models. The second method, model referencing, is
covered later. You cannot edit a block that you add to a model from a library in
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the context of the model. To edit the block, you must do so in the library. This
ensures that instances of the block in different models remain consistent.

Command Signal Error Checking Subsystem
Open the Pos_Command_Arbitration subsystem by double clicking the
subsystem block. The Stateflow® diagram performs basic error checking on
the two command signals. If the commanded signals are too far apart, the
Stateflow diagram sets the output to a fail_safe position.

Understanding the Simulation Testing Environment
You test the throttle controller model in a separate model called a test harness.
A test harness is a model that evaluates the control algorithm and offers the
following advantages:

• Separates test data from the control algorithm

• Separates the plant or feedback model from the control algorithm

• Provides a reusable environment for multiple versions of the control
algorithm

A common simulation testing environment consists of the following parts:

• Unit under test

• Test vector source

• Evaluation and logging

• Plant or feedback system

• Input and output scaling

1 Open the test harness model by entering rtwdemo_PCGEvalHarness at
the MATLAB command line.
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2 View the unit under test model reference parameters by right-clicking
the Unit_Under_Test subsystem and selecting Model Reference
Parameters.

The control algorithm is the unit under test. The control algorithm is
referenced in the test harness using a Model Reference block. The Model
Reference block provides a second method for reusing components. The
referenced model is selected in the Model Reference dialog.
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The Model Reference block allows other models to be referenced (directly or
indirectly) from the top model as compiled functions. By default, Simulink®

software compiles the model when the referenced model is changed.
Compiled functions have several advantages over libraries:

• Simulation time is faster for large models.

• You can directly simulate compiled functions.

• The simulation requires less memory. One copy of the compiled model is
in memory, even when the model is referenced multiple times.

3 Open the test vector source subsystem double clicking the subsystem
labeled Test_Vectors.
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The model uses a Signal Builder block for the test vector source. The block
has data that drives the simulation (pos_rqst) and the expected results
used by the Verification subsystem. The model uses only one set of test
data. Typically, you would create a test suite that fully exercises the system.

4 Open the Verification subsystem.

The test harness compares the simulation results against golden data: a set
of test results that have been certified by an expert to exhibit the desired
behavior for the model. In this model, the V&V Assertion block compares
the plant’s simulated throttle value position against the golden value
provided by the test harness. If the difference between the two signals is
greater than 5%, the test fails and the Assertion block stops the simulation.

Alternatively, you can evaluate the simulation data after the simulation
completes execution. You can use either M-file scripts or third-party tools
to perform the evaluation. Post-execution evaluation provides greater
flexibility in the analysis of the data. However, it requires waiting until
execution is complete. Combining the two methods can provide a highly
flexible and efficient test environment.

5 Open the Plant subsystem.

The throttle dynamics are modeled with a transfer function that is broken
down into its canonical form. You can create plant models to any level of
fidelity. It is not uncommon to have different plant models used at different
stages of testing.

6 Open the Input_Signal_Scaling and Output_Signal_Scaling
subsystems.
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The subsystems that scale input and output perform three primary
functions:

• Select signals to route to the unit under test and plant.

• Rescale signals between engineering units and units required by the
unit under test.

• Handle rate transitions between the plant and the unit under test.

Running the Simulation Tests

1 Set up your C compiler by entering mex -setup at the MATLAB command
line and specifying a valid, installed compiler.

2 Set your working directory to a directory to which you have write access.

3 In the toolbar of the rtwdemo_PCGEvalHarness model, click the Start
button to run the test harness model simulation.

The first time the test harness runs, the referenced model is compiled. You
can monitor the compilation progress in the MATLAB Command Window.

When the model simulation is complete, Simulink software displays the
results in a plot window.

The lower right plot shows the difference between the expected (golden)
throttle position and the throttle position calculated by the plant. If
the difference between the two values had been greater than ±0.05, the
simulation would have stopped.
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Viewing the Configuration Options for Code
Generation
The first step to preparing a model for code generation is to set model
configuration parameters. The configuration parameters determine the
method Real-Time Workshop software uses to generate the code and
the resulting format. One way of setting the parameters is to use the
Configuration Parameters dialog, directly accessible through the model’s
Simulation menu. Equivalently, open the Model Explorer, accessible through
the model’s View menu.

This tutorial focuses on four areas of model configuration:

• Solver options
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• Optimization options

• Hardware implementation options

• Real-Time Workshop options

1 Open the Model Explorer and click Configuration Preferences in the
Model Hierarchy pane.

2 Open the Solver pane.

For Real-Time Workshop software to generate code for a model, you must
configure the model to use a fixed-step solver. The start and stop time do
not affect generated code.

Option Required Setting Effect on Generated
Code

Start time and Stop
time

Any No effect
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Option Required Setting Effect on Generated
Code

Type Fixed-step Code is not generated
unless fixed step

Solver Any Controls selected
integration algorithms

Fixed-step size Must be lowest
common multiple of
all rates in the system

Sets base rate of the
system

Tasking mode for
periodic sample
times

SingleTasking or
MultiTasking

MultiTasking
generates one entry
point function for each
rate in the system

3 Open the Optimization pane.
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The Optimization pane includes the following subpanes.
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Subpane Effect

Simulation and code generation Removes unused branches from
the code and controls creation of
temporary variables

Signals Reduces the number of temporary
variables created by collapsing
multiple computations into a
single assignment and by reusing
temporary variables

Data initialization Controls which signals have explicit
initialization code

Integer and fixed-point Enables and disables use of
overflow and division-by-zero
protection code

4 Open the Hardware Implementation pane.

2-17



2 Learning and Using Real-Time Workshop® Embedded Coder™ Software

Use hardware implementation parameters to specify the word size and
byte ordering of the target hardware. The demo targets a generic 32-bit
processor.

5 Open the Real-Time Workshop pane.
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The Real-Time Workshop pane is where you specify the system target file
(STF). This demo uses the Real-Time Workshop® Embedded Coder™ STF
(ert.tlc). You can extend this STF to create a customized configuration.
Some of the basic configuration options reachable from the Real-Time
Workshop pane include:

• Selection of the code generator target:

– ert.tlc - "Base" Embedded Real-Time Target

– grt.tlc - "Base" Generic Real-Time Target

– Hardware specific targets

• Selected make file

• Code formatting options:

– Line length

– Use of parentheses

– Header file information

– Variable naming conventions

• Inclusion of custom code:

– C files

– H files

– Object files

– Directory paths

• Generation of ASAP2 files

Generating Code for the Model
Use one of the following methods to generate code for the
rtwdemo_PCG_eval_P1 model:

• With the model in focus, enter Ctrl+B from your keyboard.

• Choose Configuration Parameters > Real-Time Workshop > Generate
code.

• Choose Tools > Real-Time Workshop > Build Model.
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Real-Time Workshop software generates several files. The resulting code,
while computationally efficient, is not yet organized for integration into the
production environment.

Examining the Generated Code
The code generation process results in multiple files that you can view from
the Model Explorer. In addition to the standard C and H files, a set of HTML
files is generated. The HTML files provided active links between the code
and the model.

Note You must generate code before you can view the files.

1 In the Model Explorer Model Hierarchy pane, select Code for
rtwdemo_PCG_Eval_P1.

2 In the Contents pane, select HTML Report.

3 In the Real-Time Workshop HTML report, click rtwdemo_PCG_Eval_P1.c.

In the generated code, note that:

• All of the controller code is contained in one function
called rtwdemo_PCG_Eval_P1_step and found in the file
rtwdemo_PCG_Eval_P1.c.

• The operations of multiple blocks are collapsed into one equation.

• Variables are initialized in the function
rtwdemo_PCG_Eval_P1_initialize.

• All data is defined using Real-Time Workshop data structures (for
example, rtwdemo_PCG_Eval_P1_U.pos_rqst).
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You can view any of the files by clicking on the links in the table below, or by
exploring the generated code subdirectory from your working directory and
locating the individual files.

File Description

rtwdemo_PCG_Eval_P1.c C file with step and initialization
function

rtwdemo_PCG_Eval_P1_data.c C file that assigns values to
Real-Time Workshop data structures

ert_main.c Example Main file that includes a
simple scheduler

rtwdemo_PCG_Eval_P1.h H file that defines data structures

PCG_Eval_p1_private.h File that defines data used only by
the generated code

rtwdemo_PCG_Eval_P1_types.h H file that defines the model data
structure
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See Also

• “Supporting Model Referencing” in the Real-Time Workshop Embedded
Coder documentation

• “Code Generation and the Build Process” in the Real-Time Workshop
documentation

• “Configuration Parameters” in the Real-Time Workshop Embedded Coder
documentation

• “Working with Signal Groups” in the Simulink documentation

• Simulink® Verification and Validation™ documentation
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Configuring the Data Interface

In this section...

“Introduction” on page 2-23

“Declaring Data and Functions” on page 2-23

“Controlling Data in Simulink® Software and Stateflow® Software” on page
2-26

“Adding New Data Objects” on page 2-29

“Configuring Data Objects ” on page 2-30

“Controlling File Placement of Parameter Data” on page 2-30

“Enabling Data Objects in Generated Code” on page 2-31

“Effects of Simulation on Data Typing” on page 2-32

“Viewing Data Objects in Generated Code” on page 2-33

“Managing Data” on page 2-36

“See Also” on page 2-37

Introduction
This tutorial covers the specification of signals and parameters in the
generated code.

In this tutorial you learn how to control the following attributes of signals and
parameters in the generated code:

• Name

• Data type

• Data storage class

Declaring Data and Functions
Most programming languages require that you declare data and functions
before using them. The declaration specifies the following:
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Data and
Function
Attribute

Description

Scope The region of the program that has access to the data

Duration The period during which the data is resident in memory

Data type The amount of memory allocated for the data

Initialization A value, a pointer to memory, or NULL

The combination of scope and duration is the storage class. If you do not
provide an initial value, most compilers assign a zero value or a null pointer.

Supported Data Types

Name Description

double Double-precision floating point

single Single-precision floating point

int8 Signed 8-bit integer

uint8 Unsigned 8-bit integer

int16 Signed 16-bit integer

uint16 Unsigned 16-bit integer

int32 Signed 32-bit integer

uint32 Unsigned 32-bit integer

Fixed Point 8-, 16-, 32-bit word lengths

Supported Storage Classes

Name Description Parameters
Supported

Signals
Supported

Data Types

Const Use const type
qualifier in
declaration

Y N All
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Supported Storage Classes (Continued)

Name Description Parameters
Supported

Signals
Supported

Data Types

ConstVolatile Use const
volatile type
qualifier in
declaration

Y N All

Volatile Use volatile
type qualifier in
declaration

Y Y All

ExportToFile Generate and
include files, with
user-specified
name, containing
global variable
declarations and
definitions

Y Y All

ImportFromFile Include
predefined
header files
containing
global variable
declarations

Y Y All

Exported
Global

Declare and
define variables
of global scope

Y Y All

Imported
Extern

Import a variable
defined outside of
the scope of the
model

Y Y All

BitField Embed Boolean
data in a named
bit field

Y Y Boolean
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Supported Storage Classes (Continued)

Name Description Parameters
Supported

Signals
Supported

Data Types

Define Represent
parameters with
a #define macro

Y N All

Struct Embed data in a
named struct to
encapsulate sets
of data

Y Y All

Controlling Data in Simulink® Software and
Stateflow® Software
Two methods are available for declaring data in Simulink® software and
Stateflow® software: data objects and direct specification. This tutorial uses
the data object method. Both methods allow full control over the data type
and storage class. You can mix the two methods in a single model.

You can use data objects in a variety of ways in the MATLAB® and Simulink
environment. The tutorial focuses on three types of data objects:

• Signal

• Parameter

• Bus

The code generator uses data objects from the MATLAB base workspace. You
can create and inspect them by entering commands at the MATLAB command
line or by using the Model Explorer.

1 Open the model rtwdemo_PCG_Eval_P2.

2 Open the Model Explorer and view the pos_cmd_one data object in the
base workspace.
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You can also view the definition of Simulink signal object pos_cmd_one by
entering pos_cmd_one at the MATLAB command line:

pos_cmd_one =

Simulink.Signal (handle)

RTWInfo: [1x1 Simulink.SignalRTWInfo]

Description: 'Throttle position command from the first PI controller'

DataType: 'double'

Min: -1

Max: 1

DocUnits: 'Norm'

Dimensions: -1

Complexity: 'auto'

SampleTime: -1

SamplingMode: 'auto'

InitialValue: '0'
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A data object has a mixture of active and descriptive fields. Active fields affect
simulation or code generation. Descriptive fields do not affect simulation or
code generation, but are used with data dictionaries and model-checking tools.

• Active fields:

- Data type

- Storage class

- Value (parameters)

- Initial value (signals)

- Alias (define a different name in the generated code)

- Dimension (inherited for parameters)

- Complexity (inherited for parameters)

• Descriptive fields:

- Minimum

- Maximum

- Units

- Description

To view other signal objects, click the object name in Model Explorer or
enter the object name at the MATLAB command line. The following table
summarizes object characteristics for this model.

Object
Characteristics

pos_cmd_one pos_rqst P_InErrMap ThrotComm* ThrottleCommands*

Description Top-level
output

Top-level
input

Calibration
parameter

Top-level
output
structure

Bus definition

Data Type Double Double Auto Auto Struct

Storage Class Exported
Global

Imported
Extern
Pointer

Constant Exported
Global

None
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* ThrottleCommands defines a Simulink Bus object, ThrotComm is the
instantiation of the bus. If the bus is a nonvirtual bus, the signal generates a
structure in the C code.

As in C, you can use a bus definition (ThrottleCommands) to instantiate
multiple instances of the structure. In a model diagram, a bus object appears
as a wide line with central dashes, as shown below.

Adding New Data Objects
You can create data objects for named signals, states, and parameters. To
associate a data object with a construct, the construct must have a name.

The Data Object Wizard is a tool that finds constructs for which you can
create data objects, and then creates the objects for you. The model includes
two signals that are not associated with data objects: fbk_1 and pos_cmd_two.

To find the signals and create data objects for them:

1 Open the Data Object Wizard: Tools > Data Object Wizard in the model
menu bar.

2 Click the Find button to find candidate constructs.

3 Click the Check All button to select all candidates.

4 Click the Apply Package button to apply the default Simulink package
for the data objects.

5 Click the Create button to create the data objects.
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Configuring Data Objects
The next step is to set the data type and storage class:

1 Open the Model Explorer and view the base workspace.

2 For each object listed in the following table:

a Click the signal name in the Contents pane.

b Change the field settings in the Data pane to match those in the table.

Data Object Data Type Storage Class

fbk_1 Double Imported Extern

pos_cmd_two Double Exported Global

Controlling File Placement of Parameter Data
Real-Time Workshop® Embedded Coder™ software allows you to control the
files in which the parameters and constants are defined. In this tutorial, all
parameters were written to the file eval_data.c.

To change the placement of parameter and constant definitions, set the
appropriate data placement options for the model configuration.

1 Within the Model Explorer, enter the data options in the Configuration
> Real-Time Workshop > Data Placement pane, as shown in the
following figure.
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2 The generated code that results for eval_data.c is shown below:

/* Const memory section */

17 /* Definition for custom storage class: Const */

18 const real_T I_Gain = -0.03;

19 const real_T I_InErrMap[9] = { -1.0, -0.5, -0.25, -0.05, 0.0, 0.05, 0.25, 0.5,

20 1.0 } ;

21

22 const real_T I_OutMap[9] = { 1.0, 0.75, 0.6, 0.0, 0.0, 0.0, 0.6, 0.75, 1.0 } ;

23

24 const real_T P_Gain = 0.74;

25 const real_T P_InErrMap[7] = { -1.0, -0.25, -0.01, 0.0, 0.01, 0.25, 1.0 } ;

26

27 const real_T P_OutMap[7] = { 1.0, 0.25, 0.0, 0.0, 0.0, 0.25, 1.0 } ;

Enabling Data Objects in Generated Code
The next step is to ensure that the data objects you have created appear in
the generated code:

1 In the Model Explorer, make sure the Configuration > Optimizations >
Inline parameters check box is selected.

2 Enable a signal in generated code:

a In the model, right-click the pos_cmd_one signal line.

b Select Signal Properties. A Signal Properties dialog box appears.

c Make sure the Signal name must resolve to a Simulink signal
object check box is selected.
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3 Enable all of the signals in the model simultaneously by entering at the
MATLAB command line

disableimplicitsignalresolution('rtwdemo_PCG_Eval_P2')

Effects of Simulation on Data Typing
In rtwdemo_PCG_Eval_P2, all data types are set to double. Since Simulink
software uses the double data type for simulation, no changes are expected
in the model behavior when you run the generated code. To verify this, run
the test harness model. The test harness model is automatically updated to
include the rtwdemo_PCG_Eval_P2 model. That is the only change made to
the test harness.

1 Open the test harness by entering rtwdemo_PCGEvalHarness at the
command line.

2 Start the test harness.

The resulting plot shows that the difference between the golden and
simulated versions of the model remains zero.
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Viewing Data Objects in Generated Code
View the file rtwdemo_PCG_Eval_P2.c to see how the use of data objects
changed the generated code.

1 Generate code from the rtwdemo_PCG_Eval_P2 model.

2 View the model step function generated code in rtwdemo_PCG_Eval_P2.c,
located in the generated code subdirectory for this model.

The following figure shows the code for function rtwdemo_PCG_Eval_P2_step
as it appears in rtwdemo_PCG_Eval_P2.c before the use of data objects.
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The figure below shows the code as it appears in rtwdemo_PCG_Eval_P2.c
with data objects used.
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This figure shows that most of the Real-Time Workshop®

data structures have been replaced with user-defined data
objects. The local variable rtb_Sum2 and the state variable
rtwdemo_PCG_Eval_P2_DWork.Discrete_Time_Integrator1_DSAT still use
the Real-Time Workshop data structures.

Click the file names in the following table to view generated code.

Files generated for rtwdemo_PCG_Eval_P2

File Definition Notes

rtwdemo_PCG_Eval_P2.c Provides step and
initialization function

Uses the defined data objects

eval_data.c Assigns values to the defined
parameters

Has the file name specifically
defined
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Files generated for rtwdemo_PCG_Eval_P2 (Continued)

File Definition Notes

eval_data.h Provides extern definitions to
the defined parameters

Has the file name specifically
defined

ert_main.c Provides scheduling
functions

No change

rtwdemo_PCG_Eval_P2.h Defines data structures Using data objects shifted
some parameters out of this
file into user_data.h

PCG_Eval_p2_private.h Defines private (local) data
for the generated functions

Objects now defined in
eval_data were removed

rtwdemo_PCG_Eval_P2_types.h Defines the model data
structure

No change

rtwtypes.h Provides mapping to data
types defined by Real-Time
Workshop software

Used for integration with
external systems

Managing Data
Data objects exist in the MATLAB base workspace. They are saved in a
separate file from the model. To save the data manually, enter save at the
MATLAB command line.

The separation of data from the model provides many benefits:

• One model, multiple data sets:

- Use of different data types to change the targeted hardware (for example,
for floating-point and fixed-point targets)

- Use of different parameter values to change the behavior of the
control algorithm (for example, for reusable components with different
calibration values)

• Multiple models, one data set:

- Sharing of data between Simulink models in a system
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- Sharing of data between projects (for example, transmission, engine, and
wheel controllers might all use the same CAN message data set)

See Also

• “Working with Data” in the Simulink documentation

• “Custom Storage Classes” in the Real-Time Workshop Embedded Coder
documentation

• “Managing File Placement of Data Definitions and Declarations” in the
Real-Time Workshop Embedded Coder documentation
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Partitioning Functions in the Code

In this section...

“Introduction” on page 2-38

“About Atomic and Virtual Subsystems” on page 2-38

“Viewing Changes in the Model Architecture” on page 2-39

“Controlling Function Location and File Placement in Generated Code”
on page 2-40

“Understanding Reentrant Code” on page 2-43

“Using a Mask to Pass Parameters into a Library Subsystem” on page 2-44

“Generating Code from an Atomic Subsystem” on page 2-45

“Generating Code: Full Model versus Exported Functions” on page 2-47

“Effect of Execution Order on Simulation Results” on page 2-48

“See Also” on page 2-50

Introduction
This tutorial shows how to associate subsystems in the model with specific
function names and files. You examine:

• How to specify function and file names in generated code

• Parts of generated code required for integration

• How to generate code for atomic subsystems

• Data required to execute a generated function

About Atomic and Virtual Subsystems
The models in “Understanding the Demo Model” on page 2-5 and “Configuring
the Data Interface” on page 2-23 use virtual subsystems. Virtual subsystems
visually organize blocks, but have no effect on the functional behavior of the
model. Atomic subsystems evaluate all included blocks as a unit. In addition,
atomic subsystems allow you to specify additional function partitioning
information. Atomic subsystems display graphically with a bold border.
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Viewing Changes in the Model Architecture
This module shows you how to replace the virtual subsystems in the model
with function call subsystems. Function call subsystems:

• Are always atomic subsystems

• Allow the direct control of subsystem execution order

• Are associated with a function call signal

• Are executed when the function call signal is triggered

You might have to exert direct control over execution order if you intend the
model to match an existing system with a specific execution order.

The following figure of the rtwdemo_PCG_Eval_P3 model identifies function
call subsystems (1) as PI_ctrl_1, PI_ctrl_2, and Pos_Command_Arbitration:
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The subsystem Execution_Order_Control (2) has been added to the model.
It is a Stateflow® chart that models the calling functionality of a scheduler.
It controls the execution order of the function call subsystems. Later, this
tutorial examines how changing execution order (3) can change the simulation
results.

Four signal conversion blocks (4) were added to the outports for the PI
controllers to make the functions reentrant. This is discussed in more detail
later in this module.

Controlling Function Location and File Placement in
Generated Code
In “Understanding the Demo Model” on page 2-5 and “Configuring the Data
Interface” on page 2-23, Real-Time Workshop® software generates a single
model_step function that contains all the control algorithm code. However,
many applications require a greater level of control over the location of
functions in the generated code. By using atomic subsystems, you can specify
multiple functions within a single model. You specify this information by
modifying subsystem parameters.

The following figure shows the subsystem parameters for PI_ctrl_1 and key
parameters are described below the figure.
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Parameter What the Parameter Does

Treat as
atomic unit

Enables other submenus. This parameter is automatically
selected and grayed out for atomic subsystems.

Sample time Specifies a sample time. Not present for function-call
subsystems.
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Parameter What the Parameter Does

Depends on setting, as follows.

Auto: Real-Time Workshop software determines how the
subsystem appears in the generated code. This is the
default.

Inline: Real-Time Workshop software places the
subsystem code inline with the rest of the model code.

Function: Real-Time Workshop software generates the
code for the subsystem as a function.

Real-Time
Workshop
system code

Reusable function: Real-Time Workshop software
generates a reusable function from the subsystem. All
input and output is passed into the function by argument
or by reference. Global variables are not passed into the
function.

If you select Function or Reusable function, function
name options are enabled as follows.

Auto: Real-Time Workshop software determines the
function.

Use subsystem name: The function is based on the
subsystem name.

Real-Time
Workshop
function
name
options

User Specified: You specify a unique file name.
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Parameter What the Parameter Does

If you select Function or Reusable function, file name
options are enabled as follows.

Auto: Real-Time Workshop software generates the
function code within the module generated from the
subsystem’s parent system, or, if the subsystem’s parent is
the model itself, within the model.c file.

Use subsystem name: Real-Time Workshop software
generates a separate file and names it with the name of the
subsystem or library block.

Use function name: Real-Time Workshop software
generates a separate file and names it with the function
name specified for Real-Time Workshop function name
options.

Real-Time
Workshop
file name
options

User Specified: You specify a unique file name.

Function
with
separate
data

Enabled when you set Real-Time Workshop system
code to Function.
If selected, Real-Time Workshop® Embedded Coder™
software generates subsystem function code in which the
internal data for an atomic subsystem is separated from its
parent model and is owned by the subsystem.

Understanding Reentrant Code
Real-Time Workshop Embedded Coder software supports reentrant code.
Reentrant code is a programming routine that can be used by multiple
programs simultaneously. Reentrant code is used in operating systems and
other system software that uses multithreading to handle concurrent events.
Reentrant code does not maintain state data: there are no persistent variables
in the function. Calling programs maintain their state variables and are
required to pass them into the function. Any number of users or processes can
share one copy of a reentrant routine.

To generate reentrant (reusable) code, you must first specify the subsystem as
a candidate for reuse. You do this through the subsystem parameter dialog
box.
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In some cases, the configuration of the model prevents Real-Time Workshop
software from generating reusable code. Common issues that prevent the
generation of reentrant code and corresponding solutions follow.

Cause Solution

Use of global data
on the outport of the
subsystem

Add a Signal Conversion block between the subsystem
and the signal definition.

Passing data into
the system as
pointers

In the Model Explorer, select the Configuration >
Model Referencing > Pass scalar root inputs by
value check box.

Use of global
data inside the
subsystem

Use a port to pass the global data in and out of the
subsystem.

Using a Mask to Pass Parameters into a Library
Subsystem
Subsystem masks enable Simulink® software to define subsystem parameters
outside the scope of a library block. By changing the parameter value at the
top of the library, the same library is usable with multiple sets of parameters
within the same model.

When a subsystem is reusable and masked, Real-Time Workshop software
passes the masked parameters into the reentrant code as arguments.
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Real-Time Workshop software fully supports the use of data objects in masks.
The data objects are used in the generated code.

In this model, the subsystems PI_ctrl_1 and PI_ctrl_2 have been masked.
The value of the P and I gains are set in the subsystem mask. Two new data
objects are created: P_Gain_2 and I_Gain_2.

Generating Code from an Atomic Subsystem
In “Understanding the Demo Model” on page 2-5 and “Configuring the Data
Interface” on page 2-23, you generated code at the model root level. In
addition to building at the system level, it is possible to build at the subsystem
level, as the following figure shows.
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configurable subsystem with two configurations that change the execution
order of the subsystems.

Complete the following tasks to see the results:

1 In rtwdemo_PCG_Eval_P3, set the execution order to: PI_cntl_1,
PI_cntrl_2, Pos_cmd_Arbitration:

a Right-click the Execution_Order_Control subsystem.

b On the Block Choice menu, select
PI_1_then_PI_2_then_Pos_Cmd_Arb.

2 Open the test harness model rtwdemo_PCGEvalHarness.

3 Run the test harness.

4 In rtwdemo_PCG_Eval_P3, change the execution order to
Pos_cmd_Arbitration_then_PI_1_then_PI_2.

5 Run the test harness again.

As the following figure shows, a slight variation exists in the output results
depending on the order of execution. The difference is most noticeable when
the desired input changes.
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See Also

• “Building Subsystems and Working with Referenced Models” in the
Real-Time Workshop documentation

• “Writing S-Functions for Real-Time Workshop Code Generation” in the
Real-Time Workshop documentation

• “Exporting Function-Call Subsystems” in the Real-Time Workshop
Embedded Coder documentation

• “Controlling model_step Function Prototypes” in the Real-Time Workshop
Embedded Coder documentation

• “Creating Block Masks” in the Simulink documentation
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Calling External C Functions from the Model and
Generated Code

In this section...

“Introduction” on page 2-51

“Including Preexisting C Functions in a Simulink® Model” on page 2-51

“Creating a Block That Calls a C Function” on page 2-52

“Validating the External Code in the Simulink® Environment” on page 2-53

“Validating the C Code as Part of the Simulink® Model” on page 2-55

“Calling the C Function from the Generated Code” on page 2-56

“See Also” on page 2-57

Introduction
This tutorial introduces the Legacy Code Tool as a method for calling external
functions. The Legacy Code Tool enables you to call the external function from
within the simulation and in the generated code.

In this tutorial you examine:

• How to evaluate a C function as part of a Simulink® model simulation

• How to call a C function from code generated by Real-Time Workshop®

software

Including Preexisting C Functions in a Simulink®

Model
Simulink models are one part of Model-Based Design. For many applications,
a design also includes a set of existing C functions that have already been
tested and validated. The ability to easily integrate these functions into a
Simulink model and generated code is critical to using Simulink software
in the controls development process.
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This module demonstrates how to create a custom Simulink block that calls
an existing C function. Once the block is part of the model, you can take
advantage of the simulation environment to further test the system.

As an example, the Lookup blocks (lookup tables) in the PI controllers are
replaced with calls to an existing C function. The function is defined in the
files

matlabroot/toolbox/rtw/rtwdemos/EmbeddedCoder/Overview/stage_4_files/SimpleTable.c

matlabroot/toolbox/rtw/rtwdemos/EmbeddedCoder/Overview/stage_4_files/SimpleTable.h

matlabroot represents the name of your top-level MATLAB® installation
directory.

Creating a Block That Calls a C Function
To specify a call to an existing C function, you use an S-Function block. You
can automate the process of creating the S-Function block by using the
Simulink Legacy Code Tool. Using this tool, you specify an interface for your
existing C function. The tool then uses that interface to automate creation of
an S-Function block.

Complete the steps below to create an S-Function block for an existing C
function SimpleTable.c. The first five steps create an S-Function block that
calls the specified function at each time step during simulation. The last
step creates a TLC file.

1 Create the function interface definition structure at the command line:

def=legacy_code('initialize')
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The data structure def defines the function interface to the existing C code.

2 Populate the function interface definition structure by entering the
following commands:

def.OutputFcnSpec=['double y1 = SimpleTable(double u1,',...
'double p1[], double p2[], int16 p3)'];

def.HeaderFiles = {'SimpleTable.h'};
def.SourceFiles = {'SimpleTable.c'};
def.SFunctionName = 'SimpTableWrap';

3 Create the S-function:

legacy_code('sfcn_cmex_generate',def)

4 Compile the S-function:

legacy_code('compile',def)

5 Create the S-Function block:

legacy_code('slblock_generate',def)

S-function creation is a one-time task. Once the block exists, you can reuse
it in any model.

6 Create the TLC file for the S-Function block:

legacy_code('sfcn_tlc_generate',def);

The TLC file is the component of an S-function that specifies how Real-Time
Workshop software generates code for the block.

For more information on using the Legacy Code Tool, see “Integrating
Existing C Functions into Simulink Models with the Legacy Code Tool” in
the Simulink documentation.

Validating the External Code in the Simulink®

Environment
When you integrate existing C code with a Simulink model, always validate
the results before using the code.
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In this example, you replace Lookup blocks with an existing C function. To
validate the replacement, you compare simulation results produced with
the Lookup block with results produced with the new S-Function block you
created in the preceding section.

1 Open the validation model rtwdemo_ValidateLegacyCodeVrsSim.

• The Sine Wave block produces output values from [-2 : 2].

• The input range of the lookup table is from [-1 : 1].

• The output from the lookup table is the absolute value of the input.

• The lookup table output clips the output at the input limits.

2 Run the validation model.

The following figure shows the validation results. Note that the existing C
code and the Simulink table block provide the same output values.
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Validating the C Code as Part of the Simulink® Model
After you validate the functionality of the existing C function code as a
standalone component, validate the S-function in the model. Use the test
harness model to complete the validation.
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1 Open the test harness rtwdemo_PCGEvalHarness.

2 Run the test harness.

The simulation results match the expected golden values.

Calling the C Function from the Generated Code
Real-Time Workshop software uses the TLC file to process the S-Function
block like any other block in the system. Calls to the C code of the S-Function
block:

• Can use data objects

• Are subject to expression folding, an operation that combines multiple
computations into a single output calculation:
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1 Open the model rtwdemo_PCG_Eval_P4.

2 Build the model as code.

3 Examine the generated code (PI_Control_Reusable.c).

The generated code now calls the SimpleTable C function.

The following figure shows the generated code before and after the C code
integration. Before the integration, the generated code called rt_Lookup.
After the integration, the generated code calls the C function SimpleTable.

See Also

• “Integrating Existing C Functions into Simulink Models with the Legacy
Code Tool” in the Simulink documentation

• “Writing S-Functions for Real-Time Workshop Code Generation” in the
Real-Time Workshop documentation
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Integrating the Generated Code into the External
Environment

In this section...

“Introduction” on page 2-58

“Building and Collecting the Required Data and Files” on page 2-58

“Integrating the Generated Code into an Existing System” on page 2-59

“About the Integration Environment” on page 2-59

“Matching the System Interfaces” on page 2-61

“Matching Function Call Interfaces” on page 2-63

“Building a Project in the Eclipse Environment” on page 2-64

“See Also” on page 2-65

Introduction
This tutorial provides an overview of the external build process, including
what files are required and the interfaces used to call the generated code.

In this tutorial, you explore:

• How to collect files required for building outside of the Simulink®

environment

• How to interface with external variables and functions

Building and Collecting the Required Data and Files
The code that Real-Time Workshop® software generates is dependent on
support files provided by The MathWorks. If you need to relocate generated
code to another development environment, such as a dedicated build system,
you must also relocate the required support files. You can automatically
collect all generated and necessary support files and package them in a zip
file by using the Real-Time Workshop packNGo utility. This utility uses
tools for customizing the build process after code generation, including a
buildinfo_data structure, and a packNGo function to find and package all
files needed to build an executable image, including external files you define
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in the Real-Time Workshop > Custom Code pane of the Configuration
Parameters dialog. The files are packaged in a standard zip file. The
buildinfo MAT-file is saved automatically in the directory model_ert_rtw.

1 Open the model rtwdemo_PCG_Eval_P5.

2 Save the model to your working directory.

3 Generate code for the model rtwdemo_PCG_Eval_P5.

The model is configured to run packNGo automatically after code generation.

4 To generate the zip file manually, do these steps at the MATLAB® command
line:

a Load the file buildInfo.mat (located in the subdirectory
rtwdemo_PCG_Eval_P5_ert_rtw).

b Enter the command packNGo(buildInfo).

The number of files included in the zip file depends on the version of
Real-Time Workshop® Embedded Coder™ software and the configuration
of the model you use. Not all of the files in the zip file are required by the
compiler. The compiled executable size (RAM/ROM) is dependent on the link
process. The linker should be configured to include only required object files.

Integrating the Generated Code into an Existing
System
This module covers tasks required to integrate the generated code into an
existing code base. For this evaluation, the Eclipse IDE and Cygwin/gcc
compiler are used. The required integration tasks are common to all
integration environments.

About the Integration Environment
A full embedded controls system is comprised of multiple components, both
hardware and software. Control algorithms are just one type of component.
The other standard types of components include:

• An operating system (OS)
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• A scheduling layer

• Physical hardware I/O

• Low-level hardware device drivers

In general, Real-Time Workshop Embedded Coder software does not generate
code for any of these components. Instead, it generates interfaces that connect
with the components. The MathWorks provides hardware interface block
libraries for many common embedded controllers. For examples, see the block
libraries for Target Support Package™ FM5, Target Support Package IC1,
and Target Support Package TC2.

For this evaluation, files are provided to demonstrate how you can build a
full system. The main file is

matlabroot/toolbox/rtw/rtwdemos/EmbeddedCoderOverview/stage_5_files/example_main.c

where matlabroot represents the name of your top-level MATLAB
installation directory. It is a simple main function that performs the basic
actions required to exercise the code. It is not intended as an example of
an actual application main.

Open example_main.c.

int_T main(void)

{

/* Initialize model */

PC_Pos_Command_Arbitration_Init();/* Set up the data structures for chart*/

PCG_Eval_P5_Define_Throt_Param(); /* SubSystem: '<Root>/Define_Throt_Param' */

defineImportData(); /* Defines the memory and values of inputs */

do /* This is the "Schedule" loop.

Functions would be called based on a scheduling algorithm */

{

/* HARDWARE I/O */

/* Call control algorithms */

PI_Cntrl_Reusable((*pos_rqst),fbk_1,&PCG_Eval_P5_B.PI_ctrl_1,

&PCG_Eval_P5_DWork.PI_ctrl_1);

PI_Cntrl_Reusable((*pos_rqst),fbk_2,&PCG_Eval_P5_B.PI_ctrl_2,

&PCG_Eval_P5_DWork.PI_ctrl_2);
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pos_cmd_one = PCG_Eval_P5_B.PI_ctrl_1.Saturation1;

pos_cmd_two = PCG_Eval_P5_B.PI_ctrl_2.Saturation1;

PCG_Eva_Pos_Command_Arbitration(pos_cmd_one, &Throt_Param, pos_cmd_two);

simulationLoop++;

} while (simulationLoop < 2);

return 0;

}

Functions of example_main.c include the following:

• Defines function interfaces (function prototypes)

• Includes required files for data definition

• Defines extern data

• Initializes data

• Calls simulated hardware

• Calls algorithmic functions

The order of execution of functions in example_main.c matches the
order in which the subsystems are called in the test harness and in
rtwdemo_PCG_Eval_P5.h. If you change the order of execution in
example_main.c, results produced by the executable image will differ from
simulation results.

Matching the System Interfaces
Integration requires matching both the Data and Function interfaces of
the generated code and the existing system code. In this example, the
example_main.c file defines the data through #includes and calls the
functions from the generated code.

Specifying Input Data
The system has three input signals: pos_rqst, fbk_1, and fbk_2. The two
feedback signals are imported externs and the position signal is an imported
extern pointer. Because of how the signals are defined, Real-Time Workshop
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software does not create variables for them. Instead, the signal variables are
defined in a file that is external to the MATLAB environment.

For the tutorial, the file defineImportedData.c was created. This file
is a simple C stub used to define the signal variables. The generated
code has access to the data from the extern definitions in the file
rtwdemo_PCG_Eval_P5_Private.h. In a real system, the data would come
from other software components or from hardware devices.

1 Open the file matlabroot/toolbox/rtw/rtwdemos/-
EmbeddedCoderOverview/stage_5_files/defineImportedData.c:

/* Define imported data */
#include "rtwtypes.h"
real_T fbk_1;
real_T fbk_2;
real_T dummy_pos_value = 10.0;
real_T *pos_rqst;
void defineImportData(void)
{
pos_rqst = &dummy_pos_value;

}

2 In your working directory, open the file rtwdemo_PCG_Eval_P5_private.h:

/* Imported (extern) block signals */
extern real_T fbk_1; /* '<Root>/fbk_1' */
extern real_T fbk_2; /* '<Root>/fbk_2' */

/* Imported (extern) pointer block signals */
extern real_T *pos_rqst; /* '<Root>/pos_rqst' */

Specifying Output Data
The system does not require you to do anything with the output data. However,
you can access the data by referring to the file rtwdemo_PCG_Eval_P5.h.

Open rtwdemo_PCG_Eval_P5.h.

The module “Testing the Generated Code” on page 2-66 shows how the output
data can be saved to a standard log file.
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Accessing Additional Data
Real-Time Workshop Embedded Coder software creates several data
structures during the code generation process. This tutorial did not require
access to these structures. Examples of data elements commonly needed
include:

• Block state values (integrator, transfer functions)

• Local parameters

• Time

The following table lists the common Real-Time Workshop data structures.
Depending on the configuration of the model, some or all of these structures
will appear in the generated code. In this example, the data is declared in the
file rtwdemo_PCG_Eval_P5.h.

Data Type Data Name Data Purpose

Constants model_cP Constant parameters

Constants model_cB Constant block I/O

Output model_U Root and atomic
subsystem input

Output model_Y Root and atomic
subsystem output

Internal data model_B Value of block output

Internal data model_D State information
vectors

Internal data model_M Time and other system
level data

Internal data model_Zero Zero-crossings

Parameters model_P Parameters

Matching Function Call Interfaces
Functions generated by Real-Time Workshop software have a void
Func(void) interface, by default. If the model or atomic subsystem is
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configured as reentrant code, Real-Time Workshop software creates a more
complex function prototype. As shown below, the example_main function is
configured to call the functions with the correct input arguments.

Calls to the PI_Cntrl_Reusable function use a mixture of user-defined
variables and Real-Time Workshop structures. The structures are defined in
rtwdemo_PCG_Eval_P5.h. The preceding code fragment also shows how the
structures can be mapped onto user-defined variables.

Building a Project in the Eclipse Environment
This tutorial uses the Eclipse IDE and the Cygwin GCC debugger to build
the embedded system.

1 Create a build directory (Eclipse_Build_P5).

Note If code has not been generated for the model or the zip file does not
exist, complete the steps in “Building and Collecting the Required Data and
Files” on page 2-58 before continuing to the next module.

2 Unzip the file rtwdemo_PCG_Eval_P5.zip into your build directory.

3 Delete the following files, which are replaced by example_main.c:

• rtwdemo_PCG_Eval_P5.c

• ert_main.c

• rt_logging.c
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4 Follow the link for instructions on “Installing the Eclipse IDE” on page A-2.

You can use the Eclipse debugger to step through and evaluate the
execution behavior of the generated C code. “Testing the Generated Code”
on page 2-66 includes an example on how to exercise the model with input
data.

See Also
“Relocating Code to Another Development Environment”
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Testing the Generated Code

In this section...

“Introduction” on page 2-66

“Methods for Validating Generated Code” on page 2-66

“Reusing Test Data: Test Vector Import/Export” on page 2-68

“Testing via Software in the Loop (S-Functions)” on page 2-69

“Configuring the System for Testing via Test Vector Import/Export” on page
2-72

“Testing with Test Vector Import/Export Using the Eclipse Environment”
on page 2-73

“See Also” on page 2-74

Introduction
This tutorial shows two approaches for validating the generated code: the use
of system-level S-functions and running code in an external environment.

In this tutorial you examine:

• Different methods available for testing generated code

• How to test generated code in the Simulink® environment

• How to test generated code outside of the Simulink environment

Methods for Validating Generated Code
Simulink software supports multiple system testing methods for validating
the behavior of generated code.
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Test
Method

What the
Method Does

Advantages Disadvantages

Windows
run-time
executable

Generate a
Microsoft
Windows based
executable and
run the executable
from the command
prompt.

Easy to create

Can use C
debugger to
evaluate code.

Partial emulation
of target hardware

Software
in the loop
(SIL)

Use an S-function
wrapper to include
the generated
code back into the
Simulink model.

Easy to create

Allows you to
reuse the Simulink
test environment.

Can use C
debugger to
evaluate code.

Partial emulation
of target hardware
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Test
Method

What the
Method Does

Advantages Disadvantages

Processor
in the loop
(PIL)

Download code to
a target processor
and run Simulink
software in
external mode
to communicate
with the processor.

Allows you to
reuse the Simulink
test environment.

Can use C
debugger with
the simulation.

Actual processor is
used.

Requires
additional steps
to set up test
environment.

Processor does not
run in real time.

On-target
rapid
prototyping

Run generated
code on the target
processor as part
of the full system.

Can determine
actual hardware
constraints.

Allows testing of
component within
the full system.

Processor runs in
real time.

Requires
hardware.

Requires
additional steps
to set up test
environment.

Reusing Test Data: Test Vector Import/Export
In this demo, the same test data has been used by previous modules. While
the unit under test was in the Simulink environment, this was easy to
achieve. The test data can be reused outside of the Simulink environment. To
accomplish this task:

• Save the Simulink data into a file.

• Format the data in a way that the system code can access.
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• Read the data file as part of the system code procedures.

Likewise, the test environment can be reused provided that the data from the
external environment is saved in a format that MATLAB® software can read.
In this example, the hardwareInputs.c file contains the output data from
the Signal Builder block in the test harness model.

Testing via Software in the Loop (S-Functions)

Creating the S-Function
Simulink software can automatically create an S-function wrapper for
generated C code. You can enable this option from the Model Explorer:

1 Open the model rtwdemo_PCG_Eval_P6.

2 Save the model to your workspace.

3 In the Model Explorer, open the Configuration > Real-Time Workshop
> Interface pane.

4 Select the Create Simulink (S-Function) block check box.
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5 Make sure the Generate code only check box is cleared.

6 Build the model as code.

Building the model creates an S-function. After you create the S-function,
you can save it as a model, and then use it with the test harness.
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Running the S-Function
The test harness model is reused with a modification: the Model Reference
block is replaced with the automatically generated S-function. Model
Reference blocks and the automatically generated model S-function are based
on the same technological infrastructure. As a result, Model Reference blocks
cannot include automatically generated S-functions. Standard S-functions
can be included in Model Reference blocks.

1 Open the test harness rtwdemo_PCGEvalHarnessSFun.

Notice that the S-function is used in the model.

2 Run the test harness.

Again, the results from running the generated code are the same as the
simulation results.
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Configuring the System for Testing via Test Vector
Import/Export
This module extends the integration example in “Integrating the
Generated Code into the External Environment” on page 2-58. In this case
example_main.c has simulated hardware I/O.

Open the file matlabroot/toolbox/rtw/rtwdemos/-
EmbeddedCoderOverview/stage_6_files/example_main.c.

The augmented example_main.c file now has the following order of execution:

1 Initialize data (one time)

while < endTime
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2 Read simulated hardware inputs

3 PI_cnrl_1

4 PI_ctrl_2

5 Pos_Command_Arbitration

6 Write simulated hardware outputs:

end while

The input test data is supplied by two functions, plant and hardwareInputs.

File Name Function Signature Comments

Plant.c void Plant(void) Code generated from the plant section of
the test harness. Simulates the throttle
body response to throttle commands.

HardwareInputs.c void hardwareInputs(void) Provides the pos_req signal and adds
noise from the Input_Signal_Scaling
subsystems into the plant feedback
signal.

Data logging is provided by the hand-coded function, WriteDataForEval.c.
The function is executed once the test is complete. The test data is written
to the file, PCG_Eval_ExternSimData.m. You can load the M-file into the
MATLAB environment and compare it to the simulated data.

Testing with Test Vector Import/Export Using the
Eclipse Environment
This tutorial uses the Eclipse IDE and the Cygwin GCC debugger to build
the embedded system.

1 Before building an executable in the Eclipse environment, regenerate the
code without the S-function interface.

a Open the model rtwdemo_PCG_Eval_P6.
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b In the Model Explorer, open the Configuration > Real-Time
Workshop > Interface pane.

c Make sure the Create Simulink (S-Function) block check box is
cleared.

d Build the model.

2 Create a build directory (Eclipse_Build_P6).

3 Unzip the file rtwdemo_PCG_Eval_P6.zip into your build directory.

4 Delete these files, which are replaced by example_main.c:

• rtwdemo_PCG_Eval_P6.c

• ert_main.c

• rt_logging.c

5 Follow the link for instructions on “Installing the Eclipse IDE” on page A-2.

Running the control code in Eclipse generates the file eclipseData.m. This
file was generated by the file writeDataForEval.c.

6 Plot the Eclipse results.

Compare the data from the Eclipse run and the standard test harness.

See Also
“Automatic S-Function Wrapper Generation”
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Evaluating the Generated Code

In this section...

“Introduction” on page 2-75

“Evaluating Code” on page 2-75

“About the Compiler Used” on page 2-76

“Viewing the Code Metrics” on page 2-76

“About the Build Option Configurations” on page 2-76

“Configuration 1: Reusable Functions Data Type Double” on page 2-77

“Configuration 2: Reusable Functions Data Type Single” on page 2-78

“Configuration 3: Nonreusable Functions Data Type Single” on page 2-79

Introduction
This tutorial reviews the build characteristics of the generated code. Provides
RAM/ROM data for several model configurations.

In this tutorial, you explore how different configurations affect the RAM/ROM
metric.

Evaluating Code
Generated code is evaluated based on two primary metrics: execution speed
and memory usage. There is often, though not always, a tradeoff between
execution speed and memory where faster execution requires more memory.
Memory usage is further distinguished into ROM (Read-only memory) and
RAM (Random access memory).

There are tradeoffs between using RAM and ROM:

• Accessing data from RAM is faster than accessing ROM.

• Executables and data must be stored on ROM, because RAM does not
maintain data between power cycles.
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This module shows memory requirements divided into function and data
components. Execution speed was not evaluated.

About the Compiler Used
The Metrowerks CodeWarrior was used in this evaluation.

Compiler Version Target Processor

Metrowerks
CodeWarrior

v5.5.1.1430 Power PC 565

Viewing the Code Metrics
As described in“Integrating the Generated Code into the External
Environment” on page 2-58 and “Testing the Generated Code” on page 2-66,
the generated code may require the use of utility functions. The utility
functions have a fixed overhead; their memory requirements is a one-time
cost. Because of this, the data in this module shows memory usage for:

• Algorithms: The C code generated from the Simulink® diagrams and the
data definition functions

• Utilities: Functions that are part of the Real-Time Workshop® library
source

• Full: The sum of both the Algorithm and Utilities

About the Build Option Configurations
The same configuration options are used in all three evaluations.
CodeWarrior was configured to minimize memory usage and apply all allowed
optimizations.
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Configuration 1: Reusable Functions Data Type
Double

• Source files: PCG_Eval_File_1.zip

• Data Type: All doubles

• Included Data: All data required for the build is included in the project
(including data defined as extern: pos_rqst, fbk_1, and fbk_2)

• Main Function: A modified version of example_main from “Integrating
the Generated Code into the External Environment” on page 2-58

• Function Call Method: Reusable functions for the PI controllers
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Memory Usage

Usage Type Function (bytes) Data (bytes)

Full 1764 589

Algorithms 1172 549

Utilities 592 40

Configuration 2: Reusable Functions Data Type Single
In this configuration, the data types for the model where changed from the
default of double to single.

• Source files: PCG_Eval_File_2.zip

• Data Type: All singles

• Included Data: All data required for the build is included in the project
(including data defined as extern: pos_rqst, fbk_1, and fbk_2)

• Main Function: A modified version of example_main from “Integrating
the Generated Code into the External Environment” on page 2-58
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• Function Call Method: Reusable functions for the PI controllers

Memory Usage

Usage Type Function (bytes) Data (bytes)

Full 1392 348

Algorithms 800 308

Utilities 592 40

Comparing the memory used by the algorithms in the first configuration to
the current configuration we see a large drop in the data memory, from 549
bytes to 308 bytes or 56 percent. The function size also decreased from 1172 to
800 bytes, or 68 percent. Running the simulation with data type set to single
does not reduce the accuracy of the control algorithm. Therefore, this is an
acceptable design decision.

Configuration 3: Nonreusable Functions Data Type
Single

• Source files: PCG_Eval_File_3.zip

• Data Type: All singles

• Included Data: All data required for the build is included in the project
(including data defined as extern: pos_rqst, fbk_1, and fbk_2)

• Main Function: A modified version of example_main from “Integrating
the Generated Code into the External Environment” on page 2-58

• Function Call Method: The function interface is void void. Data is
passed by global parameters.

The memory requirements for the third configuration are higher than the
second configuration. Had the data type been doubled they would have been
higher than the first configuration, as well.
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Memory Usage

Usage Type Function (bytes) Data (bytes)

Full 1540 388

Algorithms 948 348

Utilities 592 40
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Installing and Using an
IDE for the Integration and
Testing Tutorials (Optional)

Installing the Eclipse IDE and
Cygwin Debugger (p. A-2)

Installing the Eclipse IDE and the
Cygwin debugger for use with the
integration and testing tutorials.

Integrating and Testing Code with
the Eclipse IDE (p. A-4)

Testing and debugging generated
code with the Eclipse IDE and the
Cygwin debugger.
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Installing the Eclipse IDE and Cygwin Debugger

In this section...

“Installing the Eclipse IDE” on page A-2

“Installing the Cygwin Debugger” on page A-3

Installing the Eclipse IDE

Note This section explains how to install the Eclipse IDE for C/C++
Developers and the Cygwin debugger for use with the integration and
testing tutorials. Alternatively, you can use another Integrated Development
Environment (IDE) or use equivalent tools such as command-line compilers
and makefiles.

1 Download the Eclipse IDE for C/C++ Developers from the Eclipse
Downloads web page.

2 Download the Eclipse C/C++ Development Tools (CDT) that is compatible
with the Eclipse IDE you downloaded in step 1 from the Eclipse CDT
Downloads Page. For example, the Eclipse IDE 3.3 requires Eclipse CDT
4.0.

3 Unzip the downloaded Eclipse IDE zip file.

4 Create the directory c:\eclipse.

5 Copy the unzipped Eclipse IDE files to c:\eclipse.

6 Unzip the downloaded Eclipse CDT zip file.

7 Copy the contents of the directories features and plugins to the
corresponding directories in c:\eclipse.

8 Create a link to the executable file c:\eclipse\eclipse.exe on your
desktop.
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Installing the Cygwin Debugger

1 Download the Cygwin setup.exe file from the Cygwin home page.

2 Run the file setup.exe. A Cygwin Setup - Choose Installation Type dialog
appears.

3 As you follow the installation procedure,

• Select the option for installing over the Internet.

• Accept the default root directory c:\cygwin.

• Specify a local package directory. For example, specify
c:\cygwin\packages.

• Specify how you want to connect to the Internet.

• Choose a download site.

4 On the dialog for selecting packages, set the Devel category to Install by
clicking the selector icon .

5 Add the directory c:\cygwin\bin to your system’s Path variable. For
example, on an Microsoft XP system, .

a Click Start > Settings > Control
Panel > System > Advanced > Environment Variables.

b Under System variables, select the Path variable and click Edit.

c Add c:\cygwin\bin to the variable value and click OK.
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Integrating and Testing Code with the Eclipse IDE

In this section...

“Introducing Eclipse” on page A-4

“Creating a New CDT-Managed Make C Project” on page A-5

“Configuring the Debugger” on page A-6

“Starting the Debugger” on page A-8

“Setting the Cygwin Path” on page A-9

“What the Eclipse Debugger Can Do” on page A-10

Introducing Eclipse
Eclipse (www.eclipse.org) is an Integrated Development Environment for
developing and debugging embedded software. Cygwin (www.cygwin.com) is
a Linux-like environment for Windows that includes the GCC compiler and
debugger.

This section contains instructions for using the Eclipse IDE with Cygwin
tools to build, run, test, and debug projects that include code generated
by Real-Time Workshop® Embedded Coder™ software, as described in
“Integrating the Generated Code into the External Environment” on page
2-58 and “Testing the Generated Code” on page 2-66. Many other software
packages and tools also exist that can work with Real-Time Workshop
Embedded Coder software to perform similar tasks.

“Installing the Eclipse IDE and Cygwin Debugger” on page A-2 contains
instructions for installing Eclipse and Cygwin. Be sure you have installed
Eclipse and Cygwin, as explained in that section, before you proceed.

About Project Names and Filenames Used in This Section
“Integrating the Generated Code into the External Environment” on page
2-58 and “Testing the Generated Code” on page 2-66 both use the instructions
in this section, but the project names and filenames differ. Where you see ##
in a project name or filename in this section, substitute:

A-4

http://www.eclipse.org/
http://www.cygwin.com/


Integrating and Testing Code with the Eclipse IDE

• P6 if you are working in “Integrating the Generated Code into the External
Environment” on page 2-58

• P7 if you are working in“Testing the Generated Code” on page 2-66

Creating a New CDT-Managed Make C Project

1 In Eclipse, choose File > New > Project.

2 In the New Project dialog, click C > Managed Make C Project.

3 Set the Project name to PCG_Eval_##_Eclipse (where ## is P5 or P6) and
set the Location to the build directory.
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4 Set the Project Type to Executable (Gnu on Windows)

Configuring the Debugger

1 In Eclipse, choose Run > Debug.
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2 Click node C/C++ Local Application.
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3 Click the Launch New Configuration toolbar button.

4 Click the project name PCG_Eval_##_Debug.

The project name appears in the Name field.

5 Select the executable file.

Starting the Debugger

1 Click the Debug toolbar button and from the menu select project
PCG_Eval_##_Debug.
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Setting the Cygwin Path
The first time you run Eclipse, you will get an error related to the Cygwin
path:

To provide the necessary path information:

1 Click Edit Source Lookup Path in the error message.

2 Click the Add button in the Edit Source Lookup Path dialog box.

The Add Source dialog box appears.

3 Select Path Mapping in the Add Source dialog box.
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4 Click the OK button. The Edit Source Lookup Path dialog box appears.

5 In the Edit Source Lookup Path dialog box, select Path Mapping.

6 Click the Edit button.

The Path Mappings dialog box appear.

7 In the Path Mappings dialog box, click the Add button.

8 Type \cygdrive\c\ in the Compilation path field.

9 Type c:\ in the Local file system path field.

10 Click the OK button.

What the Eclipse Debugger Can Do
The next figure shows the Eclipse debugger open on a project.
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Actions and Commands
Actions and commands available in the debugger include:
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Action Command

Step into F5

Step over F6

Step out F7

Resume F8

Toggle break point Ctrl + Shift + B
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